Virtual drives

Quick installation and start-up guide
# Table of contents

1 *Introduction to the guide*

- What this chapter contains ................................................................. 7
- Compatibility .................................................................................. 7
- Safety instructions ........................................................................... 7
- Target audience .............................................................................. 7
- Purpose of the guide ........................................................................ 8
- Related documents .......................................................................... 8
- Terms and abbreviations .................................................................. 8
- Cybersecurity disclaimer ................................................................. 8
- Notes ............................................................................................ 9

2 *Installing Virtual drives*

- What this chapter contains ................................................................. 11
- Installation procedure ....................................................................... 12
  - Online installation ....................................................................... 12
  - Offline installation ....................................................................... 15
    - Prepare offline installation ...................................................... 15
    - Execute offline installation .................................................. 15

3 *Licence activation*

- What this chapter contains ................................................................. 17
- Licensing ....................................................................................... 17
- Activating license ........................................................................... 18
- Online activation ............................................................................ 22
- Offline activation ........................................................................... 24

4 *Virtual drive launcher in Drive composer pro*

- What this chapter contains ................................................................. 29
- Overview ....................................................................................... 29
- Virtual drive launcher ..................................................................... 30
  - Adding new Virtual drive .......................................................... 31
  - Drive configuration ...................................................................... 31
    - Basic settings .......................................................................... 31
    - Construction & rating .............................................................. 32
    - Options .................................................................................. 32
    - Motor .................................................................................... 33
    - Load ...................................................................................... 34
    - Settings ................................................................................ 34
  - Refresh ...................................................................................... 34
  - Duplicate drive .......................................................................... 35
  - Enabling/disabling Virtual drives ............................................... 35
  - Deleting the Virtual drives ......................................................... 35
  - Closing Drive composer pro ...................................................... 36
- IO console ...................................................................................... 37
6 Table of contents

Further information
Introduction to the guide

What this chapter contains

The chapter contains information on the compatibility, target audience and purpose of this guide. It also describes the contents of this guide and refers to a list of related documents for more information.

Compatibility

This guide compiles with ACS880 drive application program version 2.8x or later in which the Virtual drive feature is included.

This guide is compatible with the following:

- Drive composer pro commissioning tool version 2.3.1 or later
- PC with Windows 7 or 10 operating system, 8 GB central memory, Intel i5 level CPU with 2.3 GHz
- The following packages must be installed in PC:
  - Microsoft .NET Framework 4.6.2
  - Visual C++ Redistributable Packages for Visual Studio 2013 Update 5 (12.0.40660)

Safety instructions

Read and obey the complete safety instructions when you are working with physical drive/real drive.

Target audience

The reader is expected to be an automation engineering professional or an electrician and familiar with drive products and the concepts regarding their commissioning and operation, including the parameter system of ABB drives.
Purpose of the guide

This guide describes the Virtual drive launcher and instructs how to use it in the commissioning and maintenance of ABB drives.

Related documents

<table>
<thead>
<tr>
<th>Manual</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive composer Start-up and maintenance PC tool User’s manual</td>
<td>3AUA0000094606</td>
</tr>
<tr>
<td>ACS880 primary control program firmware manual</td>
<td>3AUA0000085967</td>
</tr>
<tr>
<td>FENA-01/-11/-21 Ethernet adapter module user’s manual</td>
<td>3AUA0000093568</td>
</tr>
<tr>
<td>Virtual drives quick installation and start-up guide</td>
<td>3AXD50000422128</td>
</tr>
</tbody>
</table>

Terms and abbreviations

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DI</td>
<td>Digital input</td>
</tr>
<tr>
<td>Drive</td>
<td>Frequency converter for controlling AC motors</td>
</tr>
<tr>
<td>FEN-31</td>
<td>Optional HTL incremental encoder interface module</td>
</tr>
<tr>
<td>FENA</td>
<td>Optional Ethernet adapter module</td>
</tr>
<tr>
<td>FENA-01</td>
<td>Optional Ethernet adapter module for EtherNet/IP™, Modbus TCP and PROFINET IO protocols</td>
</tr>
<tr>
<td>FENA-11</td>
<td>Optional Ethernet adapter module for EtherNet/IP™, Modbus TCP and PROFINET IO protocols</td>
</tr>
<tr>
<td>FENA-21</td>
<td>Optional Ethernet adapter module for EtherNet/IP™, Modbus TCP and PROFINET IO protocols, 2-port</td>
</tr>
</tbody>
</table>

Cybersecurity disclaimer

This product is designed to be connected to and to communicate information and data via a network interface. It is Customer's sole responsibility to provide and continuously ensure a secure connection between the product and Customer network or any other network (as the case may be). Customer shall establish and maintain any appropriate measures (such as but not limited to the installation of firewalls, application of authentication measures, encryption of data, installation of anti-virus programs, etc) to protect the product, the network, its system and the interface against any kind of security breaches, unauthorized access, interference, intrusion, leakage and/or theft of data or information. ABB and its affiliates are not liable for damages and/or losses related to such security breaches, any unauthorized access, interference, intrusion, leakage and/or theft of data or information.
Notes

- To support the main functionality of Virtual drives, open the specific port, services and software in your computer. The below table shows the required list of ports, services and software.

<table>
<thead>
<tr>
<th>Port</th>
<th>Protocol</th>
<th>Description</th>
<th>Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>443</td>
<td>https</td>
<td>WIBU license protection, User personal data storage</td>
<td>ABBDrivesLicenseManager</td>
</tr>
<tr>
<td>443</td>
<td>https</td>
<td>Installation file download</td>
<td>VirtualdrivesSetup</td>
</tr>
<tr>
<td>22350</td>
<td>TCP/UDP</td>
<td>Codemeter service</td>
<td>Codemeter</td>
</tr>
<tr>
<td>22352</td>
<td>TCP/UDP</td>
<td>Codemeter service</td>
<td>Codemeter</td>
</tr>
</tbody>
</table>

- ABB recommends to use secured protocols on connecting to external interfaces.
Installing Virtual drives

What this chapter contains
This chapter contains installation instructions to install Virtual drives.
Installation procedure

Start Virtual drive installation executable file. Installation manager starts and guides you through the installation.

- **Online installation**

  Online installation of ABB Virtual drives requires internet access as installation data is downloaded during setup.

  1. Click **Install ABB Virtual drives**.

  2. Read the license agreement and activate the check-box and then click **Next**.
3. Click **Download and Install**. Data download and installation starts.
4. Click **Finish** to end the wizard.

After successful installation, see chapter *Licence activation (page 17)* to get the license with ABB Drives License Manager. After activating the license, start Drive composer pro and navigate to **Tools** menu to start Virtual drive launcher.

For installation file, contact ABB local representative.
## Offline installation

An offline installation of ABB Virtual drives is necessary if Virtual drives is to be installed on a remote computer without internet access. Offline installation allows to download installation data with a computer that provides internet access (e.g. to a shared folder, USB stick etc.). Later, this data can be used for ABB Virtual drives installation on the desired system.

### Prepare offline installation

1. Click **Prepare Offline Installation ABB Virtual drives**.

2. Click **Download**. Data download starts.

3. Wait until download is finished completely, then specify a directory the data is to be downloaded (e.g. to a shared folder or a USB stick).

4. Click **Finish** to end the wizard.

### Execute offline installation

1. On the remote computer, open the previously defined directory and execute *start_menu.exe*.
   
   Installation manager wizard starts and guides you through the installation.

2. Click **Install ABB Virtual drives Offline**.

3. Click **Install** to start the installation.

4. Click **Finish** to end the wizard.

After successful installation, see chapter *licence activation (page 17)* to get the license with ABB Drives License Manager. After activating the license, start Drive composer pro and navigate to **Tools** menu to start Virtual drive launcher.
Licence activation

What this chapter contains
This chapter contains Virtual drives license activation information.

Licensing
Virtual drives require a valid license. You can activate the license using online and offline modes.
Activating license

1. Start Drive composer pro tool.
2. Navigate to Tools → Virtual drive launcher. ABB Drives License Manager wizard starts and guides you through the licensing procedure.

You can also go to Windows Start menu and click ABB Drives License Manager to activate the license.

3. In the license wizard, click Next.
4. Choose an activation mode and click Next.
- **Activation key**: Enable this option and enter the key. For further information on how to receive the key, contact ABB sales team.
- **Offline activation**: This is required in case of unavailability of internet on the PC.
5. Select the license lock mode according to your purchased license and click **Next**.

- If you hold a single PC license, choose **PC locked** option and proceed. This option locks the product to the current PC.
- If you hold a portable hardware for licenses (USB Dongle Stick), enable **Portable** option and choose your USB drive from the drop-down list. With this, a portable product license is created, which allows to operate on any PC.
6. Select the activation mode and click **Next**.
Select Online activation if the PC contains internet access or select Offline activation.

![ABB Drives License Manager](image)

**Note:**
In case license activation fails, check the internet connection (firewall or proxy) is not blocking `ABB Drives Licenses manager.exe` or `Codemeter.exe` to get access to ABB external license server. You can use public internet connection (mobile phone hotspot) to access license server.
Online activation

The activation data can be sent to ABB License server if the current PC contains internet access.

1. Enable Online activation and click Next.

Activation procedure starts.
Successful message is displayed after activation.

2. Click **Ok** to end the wizard.
   The product license is activated.
Offline activation

The activation data cannot be sent to the licensing server if the PC does not have internet access. In this case, the offline activation file is created. This file can be used to transfer activation data to the licensing server from another PC with internet access.

Pre-requisite: Get the product activation key from the ABB sales team.

1. Enter the activation key and click **Next**.

2. Select the license lock mode according to your purchased license and click **Next**.

3. Enable Offline activation and click **Next**.
4. Enter the license request file name and save it in the file system.
5. Upload the activation file to the below shown link.

The activation request file has been saved to
C:\Users\Inname2\Desktop

Please continue the activation process by uploading the file to
6. Select the saved activation request file and click **Upload request and continue**.

7. Click **Download activation response** to download response file.

8. Store the file to a shareable location (e.g. a shared folder or a USB stick).

9. Return to the offline PC and start ABB Drives License Manager.
10. Select *I want to continue an offline activation. Import an activation response file* and click **Next**.

11. Click **Browse** and select the activation response file from the shareable location and click **Next**. ABB Drives License Manager has been activated successfully.

12. Click **Finish** to get the activation response receipt file.

13. Enter a file name and store the activation receipt file to a shareable location.

14. Move to a PC with internet availability and upload the activation receipt file from the shareable location to the registration website (http://lc.codemeter.com/54161/depot_127/). Offline license activation is successfully completed.
Virtual drive launcher in Drive composer pro

What this chapter contains
This chapter describes the main features of Virtual drive launcher in Drive composer pro.

Overview

ABB Virtual drives are digital representations of the variable speed drives including the motor. This software is used for launching, configuring and simulating of the ABB Virtual drives.

ABB offers Virtual drive launcher as a plugin for Drive composer pro, a start-up and maintenance tool for ABB drives. The tool enables the user to set up, start, and connect to Virtual drives, set parameters, input signals and check if the expected response is available to run initial tests.

You can start Virtual drive launcher by navigating to Tools → Virtual drive launcher.
Virtual drive launcher

The figure below shows the main user interface of Virtual drive launcher.

The working area can be used either with tab or floating window. The selection between tab and floating window can be made using Drive composer pro View menu.

- **Drive size** - Displays Drive size online version for selecting an optimal motor and drive.
- **Version** - Displays Virtual drives version and available targets.
- **Refresh** - Rescans all connected drives and real drives (All drives menu pane in the Drive composer pro). You can also refresh using the main menu View → Refresh (Ctrl+R).
- **Disable all** - Disables all the Virtual drives.
- **Enable all** - Enables all the Virtual drives.
- **Delete drives** - Delete drives button opens selection option to select which drives to be deleted and then by clicking Confirm button deletes the drives.
- **Add new Virtual drive** - Enables to add new Virtual drive.
■ Adding new Virtual drive

To add a new Virtual drive:

1. Click Add new Virtual drive.
2. Enter the desired drive name in the Given name field.
3. Enter Virtual drive ID, otherwise it is generated automatically. For example, ID #1, ID #2 etc.
4. Configure Virtual drives using the tabs. For further information on tabs, see Drive configuration.
5. Click Create new drive.

The new Virtual drive is created.

Similarly, you can create multiple Virtual drives as needed by repeating steps 1 to 5.

■ Drive configuration

Basic settings

The Basic settings tab consists of Drive series, Control program type and Firmware version selections. You can select the desired selection from the drop-down list to create a new Virtual drive, following the given order. All the selections are mandatory.

1. Drive series: Shows the list of available drive series.
2. Control program type: Shows the list of control program types available for the selected drive series.
3. Firmware version: Shows the list of firmware versions available for the selected drive series and control program type.
Construction & rating

The Construction & rating tab consists of Drive type, Construction, Voltage and Size (in amperes) selections. You can select the desired selection from the drop-down list to create a new Virtual drive. All the selections are mandatory.

1. Drive type: Shows the list of available drive types.
2. Construction: Shows the list of drive construction options applicable for the selected drive type.
3. Voltage/IP Class: Shows the list of available supply voltage range/IP class.

Options

The Options tab defines Slot configuration and Analog inputs configuration selections on the control board (ZCU-12/14 or BCU-12).

You can select the desired selection from the drop-down list. All the selections are optional.

- Slot configuration: Shows the list of available optional modules. For example, FENA-11/21, FEN-31 and None.
- Analog inputs configuration: Jumpers on control board (ZCU-12/14 or BCU-12) for current/voltage mode selection. Jumper 1 for Voltage and Jumper 2 for Current.
Note:
Check the actual placement of the FEN-11/21 or FEN-31 option module corresponds between the real drive and virtual drive. Especially if the parameter back-up is made with virtual drive will be restored to real drive.

Motor
The Motor tab consists of Motor electrical data and Motor mechanical data information. The data is used to configure the electrical and mechanical parameters of motor simulated by Virtual drive. All the selections are optional.

- Motor electrical data: Enter Nominal torque, Maximum to nominal torque ratio, Nominal Cosphii and Efficiency values.
- Motor mechanical data: Enter Inertia, Mechanical friction and Windage values. Windage is a motor ventilation fan losses. For example, 0.1 means 10% of motor nominal power.
- The drive parameter groups 99 and 98 are used for motor parameters for drive's motor control. The motor parameters in Virtual drive launcher are for virtual motor model which is controlled by the drive's motor control.
Load
The Load tab consists of Load type, Inertia and External load model options. The data is used to configure parameters of simulated load for Virtual drive. All the selections are optional.

- **Load type**: Shows different type of loads.
- **Inertia**: Enter inertia value. Load inertia can be reduced on motor side of the gears.
- **External load model**: Enables/disables external load. External load model means that speed estimate can be calculated in external load model (using e.g. Robot studio) and fed back to Virtual drive. Interface block can be used in Robot studio.

Settings
The Settings tab consists of System log level selections.

- **System log level**: Shows the list of System log level options. For example, Off, Error, Warning or Info.

Refresh
The Refresh option initiates the discovery procedure for all the Virtual drives and connected real drives. When you create or delete Virtual drives, click **Refresh** to refresh the list of all the Virtual drives.
**Duplicate drive**
Duplicate drive option allows you to create a new Virtual drive with similar configuration to an already created instance.
1. Select the Virtual drive to duplicate.
2. Click on **Duplicate drive.**
3. Specify Drive name and Drive ID.
4. Click on **Copy.**

**Enabling/disabling Virtual drives**
You can enable or disable all created Virtual drives by clicking on **Enable All** or **Disable All** button.
You can also enable or disable Virtual drives individually using **Enable / Disable the drive** switch from the configuration area after selecting the drive from Virtual drive instance list.

**Deleting the Virtual drives**
To delete Virtual drives:
1. Click **Delete drives.**
2. Select the check boxes for all the Virtual drives to be deleted.
3. Click **Confirm.**
Closing Drive composer pro

When you try to close Drive composer pro while Virtual drives are enabled, the tool displays a warning message.

- Click **Yes** to disable Virtual drives and close Drive composer pro.
- Click **No** to close Drive composer pro and to resume operation of the Virtual drives after restarting Drive composer pro.

![Close virtual drives dialog](image)
IO console

The IO console in Virtual drives shows the input and output signal terminals of the drive, representing the state of a simulated control board.

To launch IO console, right-click on Virtual drive and select **IO console**. The IO console screen appears.

You can view IO console screen in a separate window by clicking on **Open as separate window**.

Using IO console, you can:
- force analog and digital inputs.
- view the status of relays, digital and analog outputs.
- define the value of actual load torque in Nm.
Further information

Product and service inquiries
Address any inquiries about the product to your local ABB representative, quoting the type designation and serial number of the unit in question. A listing of ABB sales, support and service contacts can be found by navigating to www.abb.com/searchchannels.

Product training
For information on ABB product training, navigate to new.abb.com/service/training.

Providing feedback on ABB manuals
Your comments on our manuals are welcome. Navigate to new.abb.com/drives/manuals-feedback-form.

Document library on the Internet
You can find manuals and other product documents in PDF format on the Internet at www.abb.com/drives/documents.